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Reddit	and	its	partners	use	cookies	and	similar	technologies	to	provide	you	with	a	better	experience.	By	accepting	all	cookies,	you	agree	to	our	use	of	cookies	to	deliver	and	maintain	our	services	and	site,	improve	the	quality	of	Reddit,	personalize	Reddit	content	and	advertising,	and	measure	the	effectiveness	of	advertising.	By	rejecting	non-essential
cookies,	Reddit	may	still	use	certain	cookies	to	ensure	the	proper	functionality	of	our	platform.	For	more	information,	please	see	our	Cookie	Notice	and	our	Privacy	Policy.	How	can	I	play	internet	radio	from	Foobar	via	USB	output	into	my	DAC?	I	am	specifically	interested	in	Live365	stations.	I	tried	adding	the	URL	location	but	it	did	not	work.	For
Last.fm	I	understand	there's	a	plugin	available.	Any	advice?	however	a	browse/	list	by	genres	should	be	there	rather	than	entering	individual	radios.	Thanks	for	the	links.	However,	none	of	these	have	worked	when	I	try	playing	Live365	Hi	Soulforged	-	have	you	solved	the	internet	radio	issue?	I	just	put	in	a	.pls	radio	station	location	(under	add	location)
that	is	supposed	to	stream	without	a	plug	in	but	nothing	appears	in	my	playlist.	I	wonder	if	there	is	an	option	to	search	for?	Or	does	one	need	to	select	.pls	somewhere	in	the	options?	however	a	browse/	list	by	genres	should	be	there	rather	than	entering	individual	radios.	however	a	browse/	list	by	genres	should	be	there	rather	than	entering	individual
radios.	Where	would	I	look	for	this	please?	I	am	trying	to	add	Radio	3	from	BBC	which	is	a	high	quality	stream.	Thanks.	Hi	Staxxx...I	tried	very	hard	to	get	Live365	on	Foobar	but	gave	up.	I	have	since	then	moved	to	a	SB	Touch	that	has	an	app	for	this	station.	Works	great...	Interesting....I	would	love	to	find	a	good	internet	radio	with	S/PDIF	out.	I	hear
there	is	a	reasonable	one	by	Grace	Audio,	but	it	is	only	available	in	the	US.	nowadays	an	android	device	with	a	USB	dac/Dock	should	be	cheaper	alternative	to	a	dedicated	radio	streamer	This	is	the	default	welcome	page	used	to	test	the	correct	operation	of	the	Apache2	server	after	installation	on	Debian	systems.	If	you	can	read	this	page,	it	means
that	the	Apache	HTTP	server	installed	at	this	site	is	working	properly.	You	should	replace	this	file	(located	at	/var/www/html/index.html)	before	continuing	to	operate	your	HTTP	server.	If	you	are	a	normal	user	of	this	web	site	and	don't	know	what	this	page	is	about,	this	probably	means	that	the	site	is	currently	unavailable	due	to	maintenance.	If	the
problem	persists,	please	contact	the	site's	administrator.	Debian's	Apache2	default	configuration	is	different	from	the	upstream	default	configuration,	and	split	into	several	files	optimized	for	interaction	with	Debian	tools.	The	configuration	system	is	fully	documented	in	/usr/share/doc/apache2/README.Debian.gz.	Refer	to	this	for	the	full
documentation.	Documentation	for	the	web	server	itself	can	be	found	by	accessing	the	manual	if	the	apache2-doc	package	was	installed	on	this	server.	The	configuration	layout	for	an	Apache2	web	server	installation	on	Debian	systems	is	as	follows:	/etc/apache2/|--	apache2.conf|	`--	ports.conf|--	mods-enabled|	|--	*.load|	`--	*.conf|--	conf-enabled|	`--
*.conf|--	sites-enabled|	`--	*.conf	apache2.conf	is	the	main	configuration	file.	It	puts	the	pieces	together	by	including	all	remaining	configuration	files	when	starting	up	the	web	server.	ports.conf	is	always	included	from	the	main	configuration	file.	It	is	used	to	determine	the	listening	ports	for	incoming	connections,	and	this	file	can	be	customized
anytime.	Configuration	files	in	the	mods-enabled/,	conf-enabled/	and	sites-enabled/	directories	contain	particular	configuration	snippets	which	manage	modules,	global	configuration	fragments,	or	virtual	host	configurations,	respectively.	They	are	activated	by	symlinking	available	configuration	files	from	their	respective	*-available/	counterparts.	These
should	be	managed	by	using	our	helpers	a2enmod,	a2dismod,	a2ensite,	a2dissite,	and	a2enconf,	a2disconf	.	See	their	respective	man	pages	for	detailed	information.	The	binary	is	called	apache2.	Due	to	the	use	of	environment	variables,	in	the	default	configuration,	apache2	needs	to	be	started/stopped	with	/etc/init.d/apache2	or	apache2ctl.	Calling
/usr/bin/apache2	directly	will	not	work	with	the	default	configuration.	By	default,	Debian	does	not	allow	access	through	the	web	browser	to	any	file	apart	of	those	located	in	/var/www,	public_html	directories	(when	enabled)	and	/usr/share	(for	web	applications).	If	your	site	is	using	a	web	document	root	located	elsewhere	(such	as	in	/srv)	you	may	need
to	whitelist	your	document	root	directory	in	/etc/apache2/apache2.conf.	The	default	Debian	document	root	is	/var/www/html.	You	can	make	your	own	virtual	hosts	under	/var/www.	This	is	different	to	previous	releases	which	provides	better	security	out	of	the	box.	Please	use	the	reportbug	tool	to	report	bugs	in	the	Apache2	package	with	Debian.
However,	check	existing	bug	reports	before	reporting	a	new	bug.	Please	report	bugs	specific	to	modules	(such	as	PHP	and	others)	to	respective	packages,	not	to	the	web	server	itself.	Reddit	and	its	partners	use	cookies	and	similar	technologies	to	provide	you	with	a	better	experience.	By	accepting	all	cookies,	you	agree	to	our	use	of	cookies	to	deliver
and	maintain	our	services	and	site,	improve	the	quality	of	Reddit,	personalize	Reddit	content	and	advertising,	and	measure	the	effectiveness	of	advertising.	By	rejecting	non-essential	cookies,	Reddit	may	still	use	certain	cookies	to	ensure	the	proper	functionality	of	our	platform.	For	more	information,	please	see	our	Cookie	Notice	and	our	Privacy
Policy.	Are	you	one	of	the	people	who	do	not	like	cluttered	interfaces	and	you	would	rather	have	something	that	is	easy,	plain,	and	simple?	Or	did	you	ask	yourself	if	there	is	any	software	that	does	not	use	much	memory	and	can	play	songs	excellently?	Well,	Foobar2000	is	what	you	are	looking	for!	Let	us	know	why	this	software	does	not	use	much
memory	and	if	Foobar2000	can	be	used	for	very	complicated	music	processes.	In	this	article,	we	will	discuss	how	Foobar2000	can	be	used	as	your	music	player	without	being	too	complicated	or	overwhelming.	If	you	are	a	passionate	music	fan,	let	us	go	on	and	start	reviewing	Foobar2000.	1.	Our	Verdict	Pros	It	has	a	flexible	interface.	Can	be	extended
with	plug-ins.	Effective	tagging	and	organization.	Lightweight.	Highly	customizable.	Simple	and	easy	to	use	interface.	Cons	Steep	learning	curve	The	interface	is	initially	unappealing.	Not	easy	to	skin.	Provides	little	in	terms	of	hand-holding.	Overall	Ratings	In	terms	of	its	interface,	it	is	easy	to	use,	and	simple.	It	has	a	huge	playlist,	which	you	can
control	your	songs	and	control	your	playlist.	In	addition	to	this,	you	can	also	edit	the	layout	to	fit	your	needs.	Plus,	you	can	customize	by	adding	themes	you	like.	8.6	Overall	Easy	to	use:9.0	Smooth	Playback:8.5	User	friendly:8.5	2.	What	is	Foobar2000?	Its	main	purpose	is	media	management	and	it	focuses	on	ripping	and	converting	CDs	as	well	as
copying	tracks	from	your	disc,	tagging	them	automatically	and	keeping	everything	organized	in	a	well	ordered	media	library.	To	add,	it	is	really	an	excellent	music	player	for	your	PC	and	it	is	simple	to	use.	Price	The	best	thing	about	Foobar2000	is	that	it	can	give	you	not	only	a	good	music	player	but	also	it	is	100%	FREE!	Platform	Foobar2000	is
suitable	for	Android,	iOS,	Windows	Phone,	Windows	NT,	and	MacOS.	Main	Features	Gapless	playback.	Customizable	user	interface	layout.	Advanced	tagging	capabilities.	Support	for	ripping	Audio	CDs.	Transcoding	all	supported	audio	formats	using	the	Converter	component.	Full	ReplayGain	support.	Customizable	keyboard	shortcuts.	3.	Foobar2000
Review	File	Format	Support	Here	are	the	audio	formats	that	Foobar2000	supports.	Please	see	the	chart	below:	MP3,	MP4,	AAC,	CD	Audio,	WMA,	Vorbis,	Opus,	FLAC,	WavPack,	WAV,	AIFF,	Musepack,	Speed,	AU,	SND,	and	more.	Theme	The	Foobar2000	theme	is	found	in	Quick	Appearance	Setup.	By	default,	the	background	color	is	white	but	you
have	an	option	to	replace	it	and	there	is	a	long	list	of	colors	available,	so	you	can	choose	depending	on	your	liking.	In	addition	to	this,	there	is	a	way	to	try	out	various	themes	when	you	click	the	Create	Scratchbox	without	changing	the	current	layout.	Moreover,	the	themes	can	be	exported	to	a	file	from	the	Default	User	Interface	page	in	Preferences.
Player	Controls	Foobar2000	standards	or	player	controls	are	easy	to	use	just	like	any	other	music	player.	Stop	foobar-2000-stop.png	Click	the	square	symbol	if	you	want	to	stop	the	music.	Play	foobar-2000-play.png	This	triangle	symbol	is	when	you	want	to	play	the	music.	Pause	foobar-2000-pause.png	This	symbol	is	if	you	want	to	pause	the	music.
Previous	foobar-2000-previous.png	Click	this	symbol	if	you	want	to	play	the	previous	song.	Next	foobar-2000-next.png	Click	this	symbol	if	you	want	to	move	on	with	the	next	or	play	the	next	song.	Shuffle	foobar-2000-shuffle.png	Click	this	if	you	want	to	play	a	random	song.	Playlists	In	the	Library,	you	can	find	the	Album	List	where	you	can	see	the
different	playlists	with	an	appropriate	folder.	You	can	change	it	by	order,	if	you	want	it	by	folder	structure,	by	album,	by	artist,	by	genre,	by	year,	or	by	artist/album.	Furthermore,	in	the	lower	right	section,	you	can	see	the	Filter	where	you	can	choose	what	format	you	like	such	as	MP3,	MP4,	and	more.	Editing	Options	The	Layout	Editing	Mode	of
Default	User	Interface	permits	the	users	to	easily	change	the	overall	window	layout,	add	or	remove	a	lot	of	UI	elements	and	change	their	settings.	Layout	Editing	Mode	can	also	be	activated	either	by	choosing	its	option	in	the	Main	Menu,	clicking	View	and	choosing	Layout,	or	just	clicking	the	proper	button	on	the	toolbar.	On	the	other	hand,	you	can
simply	edit	with	the	basics	such	as;	undo,	redo,	clear,	select	all,	selection,	sort,	search,	remove	duplicates,	and	more.	MP3	Tag	Support	Foobar2000	allows	tagging	files	using	data	from	MusicBrainz.	See	its	main	function	below:	Fetches	data	by	automatically	calculated	MusicBrainz	Disc	ID,	existing	Artist/Album	or	MusicBrainz	Album	ID	tags.	It	uses
the	latest	version	of	MusicBrainz	web	service,	which	corresponds	to	the	NGS	data	model.	It	supports	a	lot	of	different	tags,	including	artist,	albums,	date,	track	number/total	tracks,	and	more.	It	supports	MusicBrainz-specific	tags:	Artist	ID,	Album	ID,	Release	Group	ID,	Disc	ID,	Track	ID,	album	type,	album	status.	Missing	TOCs	can	be	submitted	to
MusicBrainz	from	the	context	menu.	4.	FAQ	Why	is	seeking	so	slow	while	playing	MP3	files?The	MP3	format	does	not	support	sample-accurate	seeking,	and	sample-accurate	seeking	is	required	by	other	features	of	Foobar2000.CUE	playback.	Furthermore,	MP3	seeking	can	not	be	optimized	either	for	CBR	files	because	frame	size	is	not	constant	since
of	padding	used,	or	for	VBR	files.	Therefore,	MP3	seeking	works	by	brute	force-walking	the	MPEG	stream	chain	and	is	appropriately	slow.	However,	this	will	get	faster	when	you	pass	through	the	same	point	of	file	for	the	second	time	since	seek	tables	have	been	built	in	the	RAM.	Why	are	some	of	my	files	not	seen	by	the	Media	Library?If	your	files	are
not	in	one	of	the	formats	natively	supported	by	Foobar2000,	in	particular	like	Monkey's	Audio,	you	need	to	download	and	install	the	compatible	decoder	component	so	that	it	will	be	able	to	see	and	play	them.	Furthermore,	if	you	have	already	installed	it,	you	need	to	remove	affected	folders	from	the	Media	Library	configuration	and	add	them	back	for
those	files	so	you	can	see	them.	How	do	I	edit	tags	of	my	files?To	do	that,	just	right-click	one	or	more	tracks	and	then	choose	Properties	from	the	context	menu.	Moreover,	numerous	additional	functionality	can	be	accessed	by	selecting	one	or	more	fields	in	the	Properties	dialog	and	then	right-clicking	them.	5.	Best	Alternative	-	Bluraycopys	Free	Blu-
ray	Player	Are	you	wondering	why	Bluraycopys	Free	Blu-ray	Player	is	the	best	alternative	for	Foobar2000?	Well,	this	software	is	an	all-around	player	and	it	has	a	free	Blu-ray	Player	that	plays	Blu-ray	disc/movies	on	a	big	screen	freely.	Also,	you	can	enjoy	HD	videos	like	MP4,	AVI,	FLV,	and	more.	Moreover,	it	has	a	higher	video	quality	and	intuitive
interface.	In	addition	to	this,	you	can	download	it	for	FREE!	Since	it	is	an	all-around	player,	it	also	offers	Blu-ray	Copy	Platinum,	Blu-ray	Ripper,	Blu-ray	Play	Software,	and	Mac	Blu-ray	Player.	Free	Download	Free	Download	Conclusion	To	conclude,	we	are	now	familiar	with	the	functions	and	features	of	Foobar2000.	We	also	talk	about	the	advantages
and	disadvantages	of	it.	Plus,	we	discover	the	benefits	of	the	editing	and	the	use	of	player	controls	effectively.	However,	if	you	are	not	satisfied	with	the	Foobar2000,	you	may	try	Bluraycopys	Free	Blu-ray	Player	since	it	is	the	best	alternative.	Did	you	find	this	helpful?	126	Votes	YESThanks	for	letting	us	know!NoThanks	for	letting	us	know!	,the	free
encyclopedia	that	anyone	can	edit.117,185	active	editors	7,001,959	articles	in	EnglishThe	English-language	Wikipedia	thanks	its	contributors	for	creating	more	than	seven	million	articles!	Learn	how	you	can	take	part	in	the	encyclopedia's	continued	improvement.Members	of	the	victorious	Blondie	crewThe	Boat	Race	2018	took	place	on	24March.
Held	annually,	The	Boat	Race	is	a	side-by-side	rowing	race	between	crews	from	the	universities	of	Oxford	and	Cambridge	along	a	4.2-mile	(6.8km)	tidal	stretch	of	the	River	Thames	in	south-west	London,	England.	For	the	third	time	in	the	history	of	the	event,	the	men's,	the	women's	and	both	reserves'	races	were	all	held	on	the	Tideway	on	the	same
day.	The	women's	race	saw	Cambridge	lead	from	the	start,	eventually	winning	by	a	considerable	margin	to	take	the	overall	record	to	4330	in	their	favour.	In	the	women's	reserve	race,	Cambridge's	Blondie	(crew	pictured)	defeated	Oxford's	Osiris	by	nine	lengths.	The	men's	reserve	race	was	won	by	Cambridge's	Goldie,	who	defeated	Oxford's	Isis	by	a
margin	of	four	lengths.	The	men's	race	was	the	final	event	of	the	day	and	completed	a	whitewash	as	Cambridge	won,	taking	the	overall	record	to	8380	in	their	favour.	The	races	were	watched	by	around	250,000	spectators	live,	and	broadcast	around	the	world.	(Fullarticle...)Recently	featured:	Radar,	Gun	Laying,	Mk.I	and	Mk.IIAndrea	NavageroNosy
KombaArchiveBy	emailMore	featured	articlesAboutKitty	Marion...	that	Kitty	Marion	(pictured)	was	force-fed	over	200	times	during	a	hunger	strike?...	that	the	North	Korean	destroyer	Choe	Hyon	is	the	largest	ship	constructed	for	the	Korean	People's	Navy?...	that	after	the	release	of	High	and	Low,	director	Akira	Kurosawa	received	telephone	calls
imitating	his	film	that	threatened	to	kidnap	his	daughter?...	that	May	Bradford	Shockley	is	why	Silicon	Valley	is	where	it	is?...	that	the	conservation	of	a	goat	might	endanger	the	survival	of	Aquilegia	paui?...	that	Joy	Laking	predicted	in	a	school	writing	assignment	that	within	ten	years	she	would	be	making	a	living	as	an	artist?...	that	the	Taiwanese
restaurant	chain	Formosa	Chang	drew	inspiration	from	McDonald's	for	its	non-greasy	atmosphere	and	corporate	practices?...	that	Haridas	Mitra	had	his	death	sentence	commuted	after	the	intervention	of	Mahatma	Gandhi?...	that	"Steve's	Lava	Chicken"	recently	became	the	shortest	song	to	enter	the	UK	Top	40?ArchiveStart	a	new	articleNominate	an
articleNgg	wa	Thiong'oKenyan	writer	and	activist	Ngg	wa	Thiong'o	(pictured)	dies	at	the	age	of	87.In	sumo,	nosato	Daiki	is	promoted	to	yokozuna.In	association	football,	Liverpool	win	the	Premier	League	title.In	motor	racing,	lex	Palou	wins	the	Indianapolis	500.In	basketball,	the	EuroLeague	concludes	with	Fenerbahe	winning	the	Final	Four
Playoff.Ongoing:	Gaza	warM23	campaignRussian	invasion	of	UkrainetimelineSudanese	civil	wartimelineRecent	deaths:	Harrison	Ruffin	TylerPhil	RobertsonMary	K.	GaillardPeter	DavidAlan	YentobGerry	ConnollyNominate	an	articleMay	31:	Dragon	Boat	Festival	in	China	and	Taiwan	(2025);	World	No	Tobacco	DayBessarion455	Petronius	Maximus,	the
ruler	of	the	Western	Roman	Empire,	was	stoned	to	death	by	a	mob	as	he	fled	Rome	ahead	of	the	arrival	of	a	Vandal	force	that	sacked	the	city.1223	Mongol	invasion	of	Kievan	Rus':	Mongol	forces	defeated	a	Kievan	Rus'	army	at	the	Battle	of	the	Kalka	River	in	present-day	Ukraine.1468	Cardinal	Bessarion	(pictured)	announced	his	donation	of	746	Greek
and	Latin	codices	to	the	Republic	of	Venice,	forming	the	Biblioteca	Marciana.1935	A	magnitude-7.7	earthquake	struck	Balochistan	in	British	India,	now	part	of	Pakistan,	killing	between	30,000	and	60,000	people.2013	An	extremely	large,	powerful,	and	erratic	tornado	struck	Central	Oklahoma,	killing	eight	people	and	injuring	more	than	150
others.Albertino	Mussato	(d.1329)Joseph	Grimaldi	(d.1837)Dina	Boluarte	(b.1962)Mbaye	Diagne	(d.1994)More	anniversaries:	May	30May	31June	1ArchiveBy	emailList	of	days	of	the	yearAboutCucumis	metuliferus,	the	African	horned	cucumber,	is	an	annual	vine	in	the	cucumber	and	melon	family,	Cucurbitaceae.	Its	fruit	has	horn-like	spines,	hence	the
name	"horned	melon".	The	ripe	fruit	has	orange	skin	and	lime-green,	jelly-like	flesh.	It	is	native	to	Southern	Africa,	where	it	is	a	traditional	food.	Along	with	the	gemsbok	cucumber	and	the	citron	melon,	it	is	one	of	the	few	sources	of	water	during	the	dry	season	in	the	Kalahari	Desert.	This	photograph,	which	was	focus-stacked	from	25	separate
images,	shows	two	C.metuliferus	fruits,	one	whole	and	the	other	in	cross-section.Photograph	credit:	Ivar	LeidusRecently	featured:	Ignace	TonenAustralian	white	ibisHell	Gate	BridgeArchiveMore	featured	picturesCommunity	portal	The	central	hub	for	editors,	with	resources,	links,	tasks,	and	announcements.Village	pump	Forum	for	discussions	about
Wikipedia	itself,	including	policies	and	technical	issues.Site	news	Sources	of	news	about	Wikipedia	and	the	broader	Wikimedia	movement.Teahouse	Ask	basic	questions	about	using	or	editing	Wikipedia.Help	desk	Ask	questions	about	using	or	editing	Wikipedia.Reference	desk	Ask	research	questions	about	encyclopedic	topics.Content	portals	A	unique
way	to	navigate	the	encyclopedia.Wikipedia	is	written	by	volunteer	editors	and	hosted	by	the	Wikimedia	Foundation,	a	non-profit	organization	that	also	hosts	a	range	of	other	volunteer	projects:	CommonsFree	media	repository	MediaWikiWiki	software	development	Meta-WikiWikimedia	project	coordination	WikibooksFree	textbooks	and	manuals
WikidataFree	knowledge	base	WikinewsFree-content	news	WikiquoteCollection	of	quotations	WikisourceFree-content	library	WikispeciesDirectory	of	species	WikiversityFree	learning	tools	WikivoyageFree	travel	guide	WiktionaryDictionary	and	thesaurusThis	Wikipedia	is	written	in	English.	Many	other	Wikipedias	are	available;	some	of	the	largest	are
listed	below.	1,000,000+	articles	DeutschEspaolFranaisItalianoNederlandsPolskiPortugusSvenskaTing	Vit	250,000+	articles	Bahasa	IndonesiaBahasa	MelayuBn-lm-gCataletinaDanskEestiEsperantoEuskaraMagyarNorsk	bokmlRomnSimple	EnglishSloveninaSrpskiSrpskohrvatskiSuomiTrkeOzbekcha	50,000+	articles
AsturianuAzrbaycancaBosanskiFryskGaeilgeGalegoHrvatskiKurdLatvieuLietuviNorsk	nynorskShqipSlovenina	Retrieved	from	"	2This	article	is	about	the	year	455.	For	other	uses,	see	455	(disambiguation).This	article	needs	additional	citations	for	verification.	Please	help	improve	this	article	by	adding	citations	to	reliable	sources.	Unsourced	material
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calendar455CDLVKorean	calendar2788Minguo	calendar1457	before	ROC1457Nanakshahi	calendar1013Seleucid	era766/767	AGThai	solar	calendar997998Tibetan	calendar(male	Wood-Horse)581	or	200	or	572to(female	Wood-Goat)582	or	201	or	571King	Genseric	sacks	Rome	(455)Year	455	(CDLV)	was	a	common	year	starting	on	Saturday	of	the
Julian	calendar.	At	the	time,	it	was	known	as	the	Year	of	the	Consulship	of	Valentinianus	and	Anthemius	(or,	less	frequently,	year	1208	Ab	urbe	condita).	The	denomination	455	for	this	year	has	been	used	since	the	early	medieval	period,	when	the	Anno	Domini	calendar	era	became	the	prevalent	method	in	Europe	for	naming	years.March	16	Emperor
Valentinian	III,	age	35,	is	assassinated	by	two	Hunnic	retainers	of	the	late	Flavius	Aetius,	while	training	with	the	bow	on	the	Campus	Martius	(Rome),	ending	the	Theodosian	dynasty.	His	primicerius	sacri	cubiculi,	Heraclius,	is	also	murdered.March	17	Petronius	Maximus,	former	domesticus	("elite	bodyguard")	of	Aetius,	becomes	(with	support	of	the
Roman	Senate)	emperor	of	the	Western	Roman	Empire.	He	secures	the	throne	by	bribing	officials	of	the	imperial	palace.	Maximus	consolidates	his	power	by	a	forced	marriage	with	Licinia	Eudoxia,	widow	of	Valentinian	III.Maximus	appoints	Avitus,	most	trusted	general,	to	the	rank	of	magister	militum	and	sends	him	on	an	embassy	to	Toulouse,	to	gain
the	support	of	the	Visigoths.	He	elevates	his	son	Palladius	to	Caesar	and	has	him	marry	Eudocia,	eldest	daughter	of	Valentinian	III.May	31	Maximus	is	stoned	to	death	by	an	angry	mob	while	fleeing	Rome.	A	widespread	panic	occurs	when	many	citizens	hear	the	news	that	the	Vandals	are	plundering	the	Italian	mainland.June	2	Sack	of	Rome:	King
Genseric	leads	the	Vandals	into	Rome,	after	he	has	promised	Pope	Leo	I	not	to	burn	and	plunder	the	city.	Genseric	sacks	the	city	for	a	period	of	two	weeks.	Eudoxia	and	her	daughters,	Eudocia	and	Placidia,	are	taken	hostage.	The	loot	is	sent	to	the	harbour	of	Ostia	and	loaded	into	ships,	from	whence	the	Vandals	depart	and	return	to	Carthage.July	9
Avitus	is	proclaimed	Roman	emperor	at	Toulouse,	and	later	recognised	by	the	Gallic	chiefs	in	Viernum	(near	Arles).September	21	Avitus	enters	Rome	with	a	Gallic	army.	He	restores	the	imperial	authority	in	Noricum	(modern	Austria)	and	leaves	a	Gothic	force	under	Remistus,	Visigoth	general	(magister	militum),	at	Ravenna.The	Ostrogoths	conquer
Pannonia	and	Dalmatia.Battle	of	Aylesford:	Prince	Vortimer	rebels	against	the	pro-Anglo-Saxon	policies	of	his	father,	Vortigern.	He	is	defeated	in	the	battle	at	Aylesford	(Kent).	Hengist	and	his	son	Oisc	become	king	of	Kent.	Horsa	and	Catigern,	brother	of	Vortimer,	are	killed.	The	Britons	withdraw	to	London	(according	to	the	Anglo-Saxon
Chronicle).Skandagupta	succeeds	Kumaragupta	I	as	ruler	of	the	Gupta	Empire	(India).	During	his	reign	he	crushes	the	Hun	invasion;	however,	the	expense	of	the	wars	drains	the	empire's	resources	and	contributes	to	its	decline.Gaero	becomes	king	of	the	Korean	kingdom	of	Baekje.[1]Earliest	recorded	date	at	Chichen	Itza	on	the	Yucatn	Peninsula
(Mexico)	(approximate	date).Barter	economy	replaces	organized	trade	as	Romans	and	other	citizens	desert	their	towns	for	the	countryside,	where	they	will	be	less	vulnerable	to	barbarian	raids	(approximate	date).The	city	of	Vindobona	(Vienna)	is	struck	by	an	epidemic	that	spreads	through	the	Roman	provinces.	The	disease	is	probably	streptococcus
or	a	form	of	scarlet	fever	with	streptococcus	pneumoniae	(approximate	date).Rusticus,	archbishop	of	Lyon	(approximate	date)Wang	Baoming,	empress	of	the	Southern	Qi	(d.	512)March	16Valentinian	III,	emperor	of	the	Western	Roman	Empire	(b.	419)Heraclius,	Roman	courtier	(primicerius	sacri	cubiculi	)May	31	Petronius	Maximus,	emperor	of	the
Western	Roman	EmpireBiyu	of	Baekje,	king	of	Baekje[1]Catigern,	prince	and	son	of	Vortigern	(approximate	date)Horsa,	leader	of	the	Anglo-Saxons	(approximate	date)Kumaragupta	I,	ruler	of	the	Gupta	Empire	(India)Niall	Noigiallach,	High	King	of	Ireland	(approximate	date)Palladius,	son	of	Petronius	Maximus	(approximate	date)Prosper	of	Aquitaine,
disciple	and	Christian	writer	(approximate	date)^	a	b	"List	of	Rulers	of	Korea".	www.metmuseum.org.	Retrieved	April	20,	2019.Retrieved	from	"	3One	hundred	years,	from	301	to	400Millennia1stmillenniumCenturies3rdcentury4thcentury5thcenturyTimelines3rdcentury4thcentury5thcenturyState
leaders3rdcentury4thcentury5thcenturyDecades300s310s320s330s340s350s360s370s380s390sCategories:Births	Deaths	Establishments	DisestablishmentsvteEastern	Hemisphere	at	the	beginning	of	the	4th	century	CE.Eastern	Hemisphere	at	the	end	of	the	4th	century	CE.The	4th	century	was	the	time	period	from	301	CE	(represented	by	the	Roman
numerals	CCCI)	to	400	CE	(CD)	in	accordance	with	the	Julian	calendar.	In	the	West,	the	early	part	of	the	century	was	shaped	by	Constantine	the	Great,	who	became	the	first	Roman	emperor	to	adopt	Christianity.	Gaining	sole	reign	of	the	empire,	he	is	also	noted	for	re-establishing	a	single	imperial	capital,	choosing	the	site	of	ancient	Byzantium	in	330
(over	the	current	capitals,	which	had	effectively	been	changed	by	Diocletian's	reforms	to	Milan	in	the	West,	and	Nicomedeia	in	the	East)	to	build	the	city	soon	called	Nova	Roma	(New	Rome);	it	was	later	renamed	Constantinople	in	his	honor.The	last	emperor	to	control	both	the	eastern	and	western	halves	of	the	empire	was	Theodosius	I.	As	the	century
progressed	after	his	death,	it	became	increasingly	apparent	that	the	empire	had	changed	in	many	ways	since	the	time	of	Augustus.	The	two-emperor	system	originally	established	by	Diocletian	in	the	previous	century	fell	into	regular	practice,	and	the	east	continued	to	grow	in	importance	as	a	centre	of	trade	and	imperial	power,	while	Rome	itself
diminished	greatly	in	importance	due	to	its	location	far	from	potential	trouble	spots,	like	Central	Europe	and	the	East.	Late	in	the	century	Christianity	became	the	official	state	religion,	and	the	empire's	old	pagan	culture	began	to	disappear.[citation	needed]	General	prosperity	was	felt	throughout	this	period,	but	recurring	invasions	by	Germanic	tribes
plagued	the	empire	from	376[1][2]	CE	onward.	These	early	invasions	marked	the	beginning	of	the	end	for	the	Western	Roman	Empire.In	China,	the	Jin	dynasty,	which	had	united	the	nation	prior	in	280,	began	rapidly	facing	trouble	by	the	start	of	the	century	due	to	political	infighting,	which	led	to	the	insurrections	of	the	northern	barbarian	tribes
(starting	the	Sixteen	Kingdoms	period),	which	quickly	overwhelmed	the	empire,	forcing	the	Jin	court	to	retreat	and	entrench	itself	in	the	south	past	the	Yangtze	river,	starting	what	is	known	as	the	Eastern	Jin	dynasty	around	317.	Towards	the	end	of	the	century,	Emperor	of	the	Former	Qin,	Fu	Jin,	united	the	north	under	his	banner,	and	planned	to
conquer	the	Jin	dynasty	in	the	south,	so	as	to	finally	reunite	the	land,	but	was	decisively	defeated	at	the	Battle	of	Fei	River	in	383,	causing	massive	unrest	and	civil	war	in	his	empire,	thereby	leading	to	the	fall	of	the	Former	Qin,	and	the	continued	existence	of	the	Eastern	Jin	dynasty.According	to	archaeologists,	sufficient	archaeological	evidence
correlates	of	state-level	societies	coalesced	in	the	4th	century	to	show	the	existence	in	Korea	of	the	Three	Kingdoms	(300/400668	CE)	of	Baekje,	Goguryeo,	and	Silla.Historians	of	the	Roman	Empire	refer	to	the	"Long	Fourth	Century"	to	the	period	spanning	the	fourth	century	proper	but	starting	earlier	with	the	accession	of	the	Emperor	Diocletian	in
284	and	ending	later	with	the	death	of	Honorius	in	423	or	of	Theodosius	II	in	450.[3]See	also:	Christianity	in	the	4th	centuryGregory	the	Illuminator	mosaic,	converted	Armenia	from	Zoroastrianism	to	ChristianityContemporary	bronze	head	of	Constantine	I	(r.	306337	AD)Early	4th	century	Former	audience	hall	now	known	as	the	Basilica,	Trier,
Germany,	is	built.Early	4th	century	The	Gupta	Empire	is	established.301:	Armenia	first	to	adopt	Christianity	as	state	religion.304439:	The	Sixteen	Kingdoms	in	China	begins.306337:	Constantine	the	Great,	ends	persecution	of	Christians	in	the	Roman	Empire	(see	also	Constantinian	shift)	and	Constantinople	becomes	new	seat	of	government	(New
Rome).Tikal	had	a	population	of	about	100,000	when	it	was	conquered	by	Teotihuacan,	less	than	a	fourth	of	its	peak	population[4]320:	Butuan	Boat	One,	the	oldest	known	Balangay,	a	multi-purpose	ship	native	to	the	Philippines	is	built.325328:	The	Kingdom	of	Aksum	adopts	Christianity.325:	Constantine	the	Great	calls	the	First	Council	of	Nicaea	to
pacify	Christianity	in	the	grip	of	the	Arian	controversy.335380:	Samudragupta	expands	the	Gupta	Empire.337:	Constantine	the	Great	is	baptized	a	Christian	on	his	death	bed.350:	About	this	time	the	Kingdom	of	Aksum	conquers	the	Kingdom	of	Kush.350400:	At	some	time	during	this	period,	the	Huns	began	to	attack	the	Sassanid	Empire.[2]350:	The
Kutai	Martadipura	kingdom	in	eastern	Borneo	produced	the	earliest	known	stone	inscriptions	in	Indonesia	known	as	the	Mulavarman	inscription	written	in	the	Sanskrit	language	using	Pallava	scripture.[5]Mid-4th	century	Dish,	from	Mildenhall,	England,	is	made.	It	is	now	kept	at	the	British	Museum,	London.Mid-4th	century	Wang	Xizhi	makes	a
portion	of	a	letter	from	the	Feng	Ju	album.	Six	Dynasties	period.	It	is	now	kept	at	National	Palace	Museum,	Taipei,	Taiwan,	Republic	of	China.365:	An	earthquake	with	a	magnitude	of	at	least	eight	strikes	the	Eastern	Mediterranean.	The	following	tsunami	causes	widespread	destruction	in	Crete,	Greece,	Libya,	Egypt,	Cyprus,	and	Sicily.376:	Visigoths
appear	on	the	Danube	and	are	allowed	entry	into	the	Roman	Empire	in	their	flight	from	the	Huns.378:	Battle	of	Adrianople:	Roman	army	is	defeated	by	the	Visigoth	cavalry.	Emperor	Valens	is	killed.378395:	Theodosius	I,	Roman	emperor,	bans	pagan	worship,	Christianity	is	made	the	official	religion	of	the	Empire.378:	Siyaj	K'ak'	conquers	Waka	on
(January	8),	Tikal	(January	16)	and	Uaxactun.Wall	painting	of	the	Council	of	Constantinople	(381)	in	the	Stavropoleos	monastery,	Romania381:	First	Council	of	Constantinople	reaffirms	the	Christian	doctrine	of	the	Trinity	by	adding	to	the	creed	of	Nicaea.383:	Battle	of	Fei	River	in	China.395:	The	Battle	of	Canhe	Slope	occurs.395:	Roman	emperor
Theodosius	I	dies,	causing	the	Roman	Empire	to	split	permanently.Late	4th	century:	Cubiculum	of	Leonis,	Catacomb	of	Commodilla,	near	Rome,	is	made.Late	4th	century:	Atrium	added	in	the	Old	St.	Peter's	Basilica,	Rome.For	a	more	comprehensive	list,	see	Timeline	of	historic	inventions	4th	century.The	Stirrup	was	invented	in	China,	no	later	than
322.[6][1]Kama	Sutra,	dated	between	c.400	BC	to	c.	300	AD.[7][8]Iron	pillar	of	Delhi,	India	is	the	world's	first	Iron	Pillar.[citation	needed]Trigonometric	functions:	The	trigonometric	functions	sine	and	versine	originated	in	Indian	astronomy.[9]Codex	Sinaiticus	and	the	Codex	Vaticanus	Graecus	1209,	are	the	earliest	Christian	bibles.[10][11]Book	of
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releases	which	provides	better	security	out	of	the	box.	Please	use	the	reportbug	tool	to	report	bugs	in	the	Apache2	package	with	Debian.	However,	check	existing	bug	reports	before	reporting	a	new	bug.	Please	report	bugs	specific	to	modules	(such	as	PHP	and	others)	to	respective	packages,	not	to	the	web	server	itself.	foobar2000	v2.25	preview,	for
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of	bug	fixes.	Download:	Windows	|	Mac	OS	Additionally,	a	refresh	of	foobar2000	for	old	Mac	OS	is	available	on	old	versions	paage.	2025-05-01	foobar2000	v2.24.4	released	for	Windows	and	Mac	OS;	various	known	bugs	have	been	fixed.	foobar2000	mobile	v1.6.8,	also	a	bug	fix	update,	has	been	released	for	Android	and	will	be	available	on	iOS	shortly.
Preview	of	next-generation	foobar2000	feature	update,	v2.25,	will	be	available	soon,	for	all	platforms.	2025-04-21	Some	sections	of	the	foobar2000	website	currently	show	Google	ads.	This	is	intended,	performance	of	Google	ads	is	being	evaluated.	If	you	don't	like	them,	get	an	ad	blocker.	View	all	news	Reddit	and	its	partners	use	cookies	and	similar
technologies	to	provide	you	with	a	better	experience.	By	accepting	all	cookies,	you	agree	to	our	use	of	cookies	to	deliver	and	maintain	our	services	and	site,	improve	the	quality	of	Reddit,	personalize	Reddit	content	and	advertising,	and	measure	the	effectiveness	of	advertising.	By	rejecting	non-essential	cookies,	Reddit	may	still	use	certain	cookies	to
ensure	the	proper	functionality	of	our	platform.	For	more	information,	please	see	our	Cookie	Notice	and	our	Privacy	Policy.	Share	copy	and	redistribute	the	material	in	any	medium	or	format	for	any	purpose,	even	commercially.	Adapt	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these
freedoms	as	long	as	you	follow	the	license	terms.	Attribution	You	must	give	appropriate	credit	,	provide	a	link	to	the	license,	and	indicate	if	changes	were	made	.	You	may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	If	you	remix,	transform,	or	build	upon	the	material,	you	must
distribute	your	contributions	under	the	same	license	as	the	original.	No	additional	restrictions	You	may	not	apply	legal	terms	or	technological	measures	that	legally	restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an
applicable	exception	or	limitation	.	No	warranties	are	given.	The	license	may	not	give	you	all	of	the	permissions	necessary	for	your	intended	use.	For	example,	other	rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	Here's	how	to	set	it	up	to	stream	audio,	including	from	YouTube	using	the	3DYD	YouTube	Source
component.Download	foobar2000.The	default	setup	is	sufficient,	but	you	can	add	components	during	the	installation	if	desired.Download	3DYD	YouTube	Source(3DYD	YT	Component	3.9.5	-	for	foobar2000,	from	download	list).	Install	the	Component:	Open	foobar2000	player.Go	to	File	>	Preferences	>	ComponentsClick	Install...,	locate	the	downloaded
.fb2k-component	file	(foo_youtube_3.9.5.fb2k-component	in	our	case),	and	select	it.Restart	foobar2000	to	activate	the	new	component.Copy	the	URL	of	the	YouTube	video	you	want	to	stream.In	foobar2000,	go	to	File	>	Youtube	Source	>	Add	multiple	URLs...Paste	the	YouTube	URL	into	the	box	and	click	OK.The	audio(s)	from	the	YouTube	video	will
start	playing	in	foobar2000.If	you	regularly	listen	to	certain	YouTube	streams,	you	can	save	them	in	a	playlist.Add	multiple	YouTube	URLs	to	the	playlist	and	Save	the	playlist	by	going	to	File	>	Save	Playlist.Go	to	File	>	Preferences	>	Playback	to	adjust	settings	such	as	buffer	length	(from	Output	tab),	replay	gain,	or	other	playback	options	to	suit	your
needs.Enhance	your	streaming	experience	by	adding	visualizations	or	DSP	effects.Go	to	View	>	Visualizations	for	visual	options,	or	File	>	Preferences	>	DSP	Manager	to	add	effects	like	Equalizer	or	Crossfader.Right-click	on	the	YouTube	stream	in	the	playlist,	choose	Convert,	and	follow	the	prompts	to	save	the	audio	as	a	file.SeeAudio	File
Conversion	Made	Easy	with	foobar2000for	more	details	regarding	how	to	efficiently	convert	and	manage	your	audio	files.	

Foobar2000	webradio.	Foobar2000	windows	11.	Internet	radio	foobar.	Internet	radio	foobar2000.


